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Welcome 
 

as the user of  RainWood’s Tick Chart indicator. This document is intended to help you with the 
installation and setup of the indicator in MetaTrader 4. Hopefully you will find it useful and will be a 
satisfied user of RW Tick Chart indicator. 

 

 

 

Table of Contents 
 

Installation .............................................................................................................................................. 3 

Change Log .............................................................................................................................................. 6 

Settings.................................................................................................................................................... 8 

Offline Charts ........................................................................................................................................ 13 

History Tick Data ................................................................................................................................... 16 

Quick Control Bar .................................................................................................................................. 18 

Additional Indicators ............................................................................................................................. 18 

Tips ........................................................................................................................................................ 19 

Contact Us ............................................................................................................................................. 20 

Risk Disclaimer ...................................................................................................................................... 20 

http://www.rwtickchart.com  All contents © Copyright 2013-2019 RainWood 
 

Page 2 

   

  



 

Installation 
 

Here are the installation steps necessary to use RainWood’s Tick Chart indicator:  

1. Download RW Tick Chart indicator from the URL provided in the email you received after the 
purchase 

2. Unpack/decompress the downloaded .ZIP file 

3. Open your MetaTrader 4 data folder 

 

To find MetaTrader 4 data folder start your MT4, open ‘File’ menu and select ‘Open Data Folder’ 

 

4. Copy the 2 files with DLL extension (RWTICKCHART.1.21.DLL and RWLIB.DLL) to the 
LIBRARIES folder inside your MetaTrader 4 data folder: 
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5. Copy the other files with EX4 extension to the INDICATORS folder inside your MT4 data 
folder: 

 

 

6. Start/restart MetaTrader 4 

7. VERY IMPORTANT  !!! 

- before using the indicator please make sure that you use MetaTrader 4.00 version build 1090 or 
higher (you can check program version in MT4 – Help menu – About) 

- setting ’Allow DLL imports’ should be enabled (this setting can be found in MT4 – Tools menu – 
Options – Expert Advisors tab) 
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8. Add RW Tick Chart indicator to any chart you wish 

9. After that you will receive a window to enter your username and password. Type the 
username and password you received in the email after your purchase. This step is required 
only once, the credentials will be saved on your computer so you won’t need to type it later 
on  

 

 

Warning:  if you miss the authentication window and it closes after some time, just restart MT4 and 
add RW Tick Chart indicator to a chart again – this will make the authentication window reappear 

 

10. Congratulations! You are ready to use RainWood’s Tick Chart indicator 
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Change Log 
 

The following changes have been applied to RW Tick Chart Indicator: 

v1.20 – v1.21 

Optimizations and bugfixes for latest builds of MetaTrader 4 

 

v1.19 

1. Option to generate history tick data from M1 candles  –  beside downloading history tick data now it is possible to generate 
history tick data from M1 candles 

2. Quick Control Bar to change tick volume and history settings on the fly   –  when clicking on the small arrow in the lower left 
corner of the indicator window a Quick Control Bar appears which makes it easier to change tick volume and history settings. 
There is also a RELOAD button which recalculates the tick chart which can be useful in case the tick chart gets corrupted 

3. Disable tick chart in indicator window to save resources   –  if only offline tick charts are used, the tick chart in the indicator 
window can be disabled to save resources 

v1.18 

1. History tick data download limit increased  –  the maximum download limit of history tick data has been increased from 2 
weeks to 6 weeks. This can be set through the ‘Max age of history tick data’ setting. The default setting is ‘8 hours’, so 8 hours 
of history tick data will be downloaded 

2. Open trades appear on the tick chart   –  current open trades are marked on the tick chart with open price, stop loss and take 
profit lines (the same way as they appear on the main chart) 

3. Automatic copying of main chart trendlines to tick chart   –  if enabled, the trendlines on the main chart will be copied to the 
tick chart 

4. Alert function added when MAs cross  –  Sound and alert window notifications can be enabled for the case when the two built-
in Moving Averages of RW Tick Chart indicator cross over  

5. Additional indicator:  Accelerator  –  MT4 built-in indicator Accelerator has been modified to be tick chart based and added as 
‘RWTC-Accelerator’.  

v1.17 

1. Additional indicators   –  some MT4 built-in indicators have been modified to be tick chart based. The new additional indicators 
in this version are Williams %R, Momentum and Standard Deviation 

2. Offline chart open button   –  if offline charts are enabled at RW Tick Chart indicator settings, a button will appear next to the 
name of the offline chart which makes it easier to open it 

v1.16 

1. Additional indicators   –  some MT4 built-in indicators (Stochastics, MACD, CCI, RSI) have been modified to be tick chart based. 
These modified indicators are now synced to the tick chart, so – although they are added to the main chart – they will move 
together with the tick chart 

2. Synced trendlines  –  RW Tick Chart indicator is now more trendline friendly, so manually created trendlines are now synced to 
the tick chart and will move together with it 

3. Support added to download history tick data from 3rd party  –  RW Tick Chart indicator is now able to download history tick 
data from 3rd party data provider and display tick chart for time periods when it wasn’t running or when MT4 was offline 
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v1.15 

1. Select Bid, Ask or Mid price as base of tick chart  –  from this version it is possible to select if the tick chart should be drawn 
based on Bid price, Ask price or Mid price 

2. Time lines and time labels  –  new option to display time lines and time labels at every minute 

3. Horizontal grid lines  –  can now be displayed with only 1 pip distance between the lines 

4. Moving price line  –  it is now possible to display a moving price line on the tick chart in the indicator window (works the same 
way as the price line on the main chart) 

5. Offline tick chart updating modified  –  every time when the offline tick charts are updated a Custom Chart Event (#3758) is 
triggered, so if an EA is added to the offline tick chart it can use this ’Custom Chart Event’ and the ’OnChartEvent’ MQL function 
to run at every tick 

v1.14 

1. Tick data loading improved  –  now it is possible to load last weeks tick data as well with the current week data (by setting 
’Maximum age of preloaded data’ to the appropriate value) 

2. Time lines and time labels  –  options have been added to display time lines and time labels at every 5th, 10th or 15th minute 

3. Offline tick charts refresh at every tick  –  offline tick charts can be set to automatically update at every tick, every 5th tick or 
whenever a tick candle is closed 

v1.13 

1. Bollinger Bands –  option added to display Bollinger Bands on tick chart in indicator window 

2. Heiken-Ashi  –  Heiken-Ashi can be applied to tick chart in indicator window  

3. Offline tick charts with real time scale  –  offline tick charts now have real, up-to-date time scale instead of the old time scale 
(old time scale started from January 1, 1970) 

4. Tick chart time hour offset  can be set  –  tick chart in indicator window can now show time hours different than broker time 
hours, you just have to set ’tick chart time hour offset’ to a non default value (e.g. if set to +3, the tick chart in the indicator 
window will show time 8:00 instead of 5:00 and 21:00 instead of 18:00, if set to -5 it will show 2:00 instead of 7:00) 

v1.12 

Compatibility update for MT4 build 600  –  MetaQuotes Software released a new build of MetaTrader with major changes in 
MQL. RW Tick Chart v1.12 has been made compatible with this new MT4 release. 

v1.11 

1. Horizontal lines/levels can be displayed  –  the tick chart in the indicator window is now able to display horizontal lines with a 
specified distance of pips between them. Please see the ’Horizontal Lines’ section at the indicator settings panel. 

2. Offline tick chart names can be simplified  –  the name of offline tick charts can be set to contain only the instrument name 
(e.g. USDJPY) without the ‘!rw’ prefix (!rwUSDJPY). This can be set by setting ’OCUseSimpleSymbolNames’ to TRUE. 

v1.10 

1. Tick data collection and saving method has been changed  –  now you can change Ticks per Candle setting without loosing 
already collected tick data since the old tick chart would be converted to a new chart based on the new indicator settings. 

2. Offline chart support has been added  –  now you can view the tick chart on offline chart as well and you can add built-in 
indicators or your own indicators to the offline tick chart. 

3. Backtesting with RW Tick Chart indicator has been enhanced  –  a new mode (Strategy Tester Fast Mode) has been introduced 
to speed up backtesting 

4. Secondary Moving Average has been added  –  now you can add a second MA line to the tick chart in the indicator window 
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Settings 

 

The following settings can be set in RW Tick Chart indicator: 

Where to display the tick chart – 
this setting defines where the tick 
chart will be displayed. There are 
3 options:  indicator window, 
offline chart or both 

 

Number of ticks per candle – sets 
how many ticks (transactions) 
should a tick chart candle contain. 
This setting is also displayed on 
the Quick Control Bar as ‘Tick 
Volume’ 

 

Tick chart based on – select if the 
tick chart should be based on Bid 
price, Ask price or Middle price. 
MT4 standard charts display the 
bid price by default, so the default 
setting for the tick chart is also the 
bid price. 

 

Update offline chart at – you can select when to update the offline tick charts. If this is set to ’tick 
candle close’, the offline chart will be updated only when a tick bar is finished and the next tick bar 
starts. If set to ’every tick’, the offline chart will refresh at every tick automatically. Other options are 
’every 5th tick’, ’every 20th tick’ and ’every 50th tick’. 

Also update if new Hi/Lo (compared to this number of last candles) – if set to ‘0’ (or offline chart 
updating is set to ‘every tick’) this function is disabled. Otherwise this number specifies the number 
of last candles whose highest high and lowest low are checked. If current price exceeds the highest 
high or lowest low of these candles, then the offline chart will be updated (even if the 5th, 20th, 50th 
tick or candle close didn’t happen yet). For example if this setting is set to ‘10’, then the last 10 
closed tick candles will be checked and if price crosses the highest high or lowest low of these 
candles, the offline chart will be refreshed. 

Offline chart name – select between a standard name (e.g. ’EURUSD,M9’) or a name with prefix 
’!rw’ (e.g. ’!rwEURUSD,M9’) for the offline chart 

Offline chart ID number – an identifier which will appear in the name of the offline chart (e.g. ID ’9’ 
for offline chart ’EURUSD, M9’)  
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Max age of history tick data – this setting defines how old (in hours) history tick data should RW Tick 
Chart indicator download/generate. This setting is also displayed on Quick Control Bar as ‘History’ 

Warning:  if ‘History Tick Data Source’ is set to ‘Download…’ and you specify a high number for this setting, you 
may have to wait longer for the tick data download to finish. The exact download time depends on your 
Internet connection speed and how many hours of history tick data will be downloaded. 

History tick data source – there are 3 options:  history tick data can be generated using M1 candles, 
it can be downloaded from a 3rd party data provider, or it can be disabled and not displayed at all.  

Difference between generated and downloaded tick data:  if ‘Generate tick data from M1 candles’ is selected, the indicator 
will use OHLC values (Open, High, Low, Close) of the M1 candles to simulate history ticks (simulation of ticks is needed 
because MT4 doesn’t store tick data). This type of tick chart is not as accurate as downloading real tick data from a 3rd 
party data provider, however it can be useful sometimes (e.g. when 3rd party tick data is not available for the given 
instrument). 

If downloading history, select the symbol – this setting is only important if you are using 
downloaded history tick data. If you use generated tick data, then you can ignore this setting. So if 
you want to use downloaded history tick data and you are adding RW Tick Chart indicator to an 
Index or Commodity chart, you will need to select the name of the Index/Commodity manually. 
Otherwise (i.e. adding the indicator to a Forex currency or Gold/Silver chart) leave this option at the 
default setting which is ’Forex & Metals:  AUTODETECT’ 

 

 

Moving Average – displaying of Moving Averages (in indicator window) can be enabled or disabled 

Hint:  you can change MA line color on the Colors tab of the indicator settings by editing the color of buffer #3 

MA method – sets the method of Moving Average calculation. Options are Simple Moving Average, 
Exponential Moving Average, Smoothed Moving Average, Linear Weighted Moving Average 

MA period – defines the period of the Moving Average. Moving Average will be displayed on the tick 
chart only after enough candles are available to calculate MA values (i.e. if there are already more 
candles on the tick chart than the period of the Moving Average). 

Example:  if you set MA period to 50, MA will be displayed on the tick chart only if there are already 50 tick candles 
available on the tick chart. 

Second Moving Average – you can add a second MA line to the tick chart in the indicator window. 
The second MA line will be visible only if ’Moving Average’ and ’Second Moving Average’ both are 
enabled 

Hint:  you can change second MA line color on the Colors tab of the indicator settings by editing the color of buffer #4 

Second MA method – methods of the second MA line can be:  Simple Moving Average, Exponential 
Moving Average, Smoothed Moving Average, Linear Weighted Moving Average 

Second MA period – period of the second MA line 

MA crossover notification – you can choose to receive sound and alert window notifications in case 
the two Moving Averages cross 
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Bollinger Bands – enable this option to display Bollinger Bands on the tick chart in indicator window 

Hint:  you can change Bollinger Band colors on the Colors tab of the indicator settings by editing the color of buffer #5 for 
the upper line and #6 for the lower line 

Hint:  to display the middle line of Bollinger you can set one of the Moving Averages to the same period as Bollinger period 
and set MA method to ’SMA’. Its color can be set at the Colors tab of the settings by editing color of buffer #3 or buffer #4 

BB period – period of Bollinger Bands 

BB deviation – deviation of Bollinger Bands 

 

Heiken-Ashi – if enabled, Heiken-Ashi will be applied to the tick chart in the indicator window 

 

Round price values to 4-digit broker price – if enabled, the indicator rounds price values to pip 
values. This setting would make a 5-digit broker tick chart look like a tick chart at a 4-digit broker. 
Usually a 4-digit broker tick chart would make candle blocks and clustering of candles more 
recognizable and could help scalping.  

Hint:  To learn more about scalping, candle blocks and clustering it is recommended to read Bob Volman’s book on Forex 
Price Action Scalping.  

 

Max number of candles in indicator window – sets the maximum number of candles that the 
indicator draws in the indicator window. Default setting is 1000 candles 

Warning:  this setting doesn’t affect the number of candles on offline tick charts (that is only affected by setting 
‘Max age of history tick data’) 

Bull Candle color – color of bull candle bodies 

Bull Candle outline color – color of bull candle borders and wicks 

Bear Candle color – color of bear candle bodies 

Bear Candle outline color – color of bear candle borders and wicks 

Doji Candle color – color of doji candles (i.e. candles with the same opening and closing price) 

Menu and button color – color of the Quick Control Bar and the offline chart opening button 

Time added to tick candle description – if enabled, opening times of tick chart candles will be added 
to the tick candle’s description field, so they can be queried from the code of Expert Advisors 

Copy main chart trendlines to tick chart – if enabled, trendlines created on the main chart will be 
copied to the tick chart in the indicator window 

Show tooltips – if enabled, moving the mouse cursor over a tick candle in the indicator window will 
result in showing the OHLC values of the tick candle in a little tooltip window 

Show open trades – specifies if currently open trades with stop loss and take profit levels should be 
displayed on the tick chart in the indicator window or not 
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Price line method – this setting defines if a 
price line is drawn in the indicator window. 
The price line is a horizontal line which 
moves constantly to reflect current price 
level. The default setting is ’NO LINES’. If set 
to ’CURRENT PRICE LINE’, the price line will 
show the price on which the tick chart is 
based (Bid, Ask or Mid price – defined at 
setting ’Tick chart based on’). If the price line 
method is set to ’BID & ASK LINES’, two price 
lines will be shown:  one for Bid price and 
another for Ask price. 

Price line style – sets the line style of price 
lines. Options are Solid, Dash, Dot, Dash-dot, 
Dash-dot-dot lines. Default setting:  Solid 

Price line color – color of price lines 

 

Time lines in indicator window – this setting 
enables time lines on the tick chart, so a 
vertical line will be displayed when a 
specified time period has elapsed 

Minutes between time lines – defines the 
time period when vertical lines will be 
displayed. Options are 1, 5, 10, 15, 30, 60, 
120, 240 minutes and AUTO. If set to AUTO, 
the indicator will calculate the optimal 
distance between time lines 

Time line style – options are Solid, Dash, Dot, 
Dash-dot, Dash-dot-dot lines. Default setting:  
Dot 

Time line color – color of time lines 

 

Display time next to time lines – display time labels next to time lines in indicator window 

Minutes between time labels – this setting defines the time period when time labels will be shown. 
Options are 1, 5, 10, 15, 30, 60, 120, 240 minutes and AUTO. If set to AUTO, the indicator will set this 

Placement of time labels – time labels can be displayed at top or bottom of the indicator window 

Tick chart time:  hour offset – with this setting you can set tick chart time to a different hour. E.g. if 
you set this value to +7, time labels in indicator window will show 11:00 instead of 4:00. If you set it 
to -4, time labels will show 19:00 instead of 23:00. Possible values are -12 to +12, default value is 0 
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Time label font size – font size of time labels 

Time label font type – font type of time labels 

Time label color – color of time labels 

 

Horizontal grid lines in indicator window – if TRUE, the tick chart in the indicator window will draw 
horizontal grid lines with specific number of pips (see ‘distance between horizontal grid lines’ setting) 
between them. By default horizontal grid lines are disabled. 

Distance between horizontal grid lines – this setting defines the distance (i.e. number of pips) 
between horizontal grid lines to be drawn on the tick chart in the indicator window. The options are:  
1, 5, 10, 20, 25, 50 or 100 pips. Default value:  100 pips 

Horizontal grid line style – sets the line style of horizontal grid lines. Options are Solid, Dash, Dot, 
Dash-dot, Dash-dot-dot lines. Default setting:  Dot 

Horizontal grid line color – color of horizontal grid lines 

Show price values of horizontal grid lines – if set to TRUE, the price values will be shown at the right 
side next to the horizontal grid lines in the indicator window of MT4. By default this is set to FALSE. 

 

 

Display current tick number – this setting enables the tick counter in the indicator window, on the 
offline tick chart or both. When the tick number reaches the tick value of the current tick chart (e.g. 
50 at a 50-tick chart), it resets to zero and starts counting again.  

Tick number display corner (ind. window) – you can place the tick counter in any corner of the 
indicator window 

Tick number display corner (offline chart) – you can place the tick counter in any corner of the 
offline tick chart 

Tick number X-offset – you can move tick counter horizontally by defining the X-offset. The offset is 
relative to the set corner (defined in ’tick number display corner’). This is for indicator window only. 

Tick number Y-offset – you can move tick counter vertically by defining the Y-offset. The offset is 
relative to the set corner (defined in ’tick number display corner’). This is for indicator window only. 

Tick number font size – font size of tick counter in indicator window 

Tick number font type – font type of tick counter in indicator window 

Tick number color – color of tick counter in indicator window 
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Offline Charts 
 

RW Tick Chart indicator supports the use of offline charts. The benefit of using offline charts is that 
you can add many custom indicators or Expert Advisors to the offline charts and as a result you will 
get tick chart based indicators (or EAs). Despite their name offline charts are not really ‘offline’ 
because they get refreshed automatically. The refresh period can be set at indicator settings panel 
with some other settings: 

Where to display the tick chart – enable offline charts by setting this option to either ‘Indicator 
window and offline chart’ or ‘Offline chart only’ 

Update offline chart at – you can set the period of the offline chart automatic refresh. Options are 
at ’every tick’, at ’every 5th tick’, at ’every 20th tick’, at ’every 50th tick’ or at ’tick candle close’.  

Update offline chart at – you can set the period of the offline chart automatic refresh. Options are 
at ’every tick’, at ’every 5th tick’, at ’every 20th tick’, at ’every 50th tick’ or at ’tick candle close’.  

Also update if new Hi/Lo (compared to this number of last candles) – this setting determines the 
number of last finished tick candles to check, and if their highest high or lowest low is exceeded by 
current price, then the offline chart will be updated. If set to ‘0’, this function is disabled.  

Offline chart ID number – the offline chart ID gives the number part behind letter ‘M’ in the name of 
offline charts. It helps to identify which offline chart you will need to open. RW Tick Chart indicator 
will display the name of the offline chart at the upper left corner of the indicator window 

Please be aware that MT4 and RW Tick Chart indicator doesn’t support offline charts while running 
backtests in MT4 Strategy Tester.  

 

Offline Chart Example:  Ichimoku added to offline tick chart 
 

To use Ichimoku indicator with an offline tick chart you can follow these example steps: 

1. add RW Tick Chart indicator to a main chart (e.g. EURUSD) 

2. at the settings panel of RW Tick Chart indicator change setting ‘Where to display the tick 
chart’ to ‘Indicator window and offline chart’. Let’s also change ‘Update offline chart’ to 
‘every tick’ and ‘Offline chart ID number’ to ‘19’. When finished click ‘OK’ 
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3. after that RW Tick Chart indicator will generate the offline tick chart from the incoming ticks. 
In the upper left corner of the indicator window you’ll see which offline chart needs to be 
opened (underlined with red on the screenshot): 

 

4. to open the offline chart you can click on the ‘OPEN’ button in the upper left corner of the 
indicator window (next to the name of the offline chart). The other method to open the 
offline chart is to open MetaTrader 4 ‘File’ menu and select ‘Open Offline’ 

 

5. if you used the second method to open the offline chart, a window will appear with a list of 
offline charts. Just select offline chart ‘EURUSD, M19’ and click ‘Open’ 
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6. when the offline tick chart appears, it will show the same tick chart which you can see in the 
indicator window of the main chart. Now you can add Ichimoku indicator to the offline chart 
just the same way as you would add it to any other chart. You can also add other indicators 
(like MACD) or even Expert Advisors to the offline tick chart. 

 

 

If you used another currency in the above example like GBPJPY with Offline Chart ID set to 17, then 
you have to open the offline chart called ‘GBPJPY, M17’.  

You also have the option to use offline chart names with prefix ‘!rw’ like ‘!rwGBPJPY’. To do that you 
need to set ‘Offline chart name’ to ‘with prefix’ at the indicator settings.  
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History Tick Data 
 

MetaTrader 4 doesn’t store tick data and as a result history tick data cannot be queried or exported 
from MT4. RW Tick Chart indicator offers two options to solve this problem and display history tick 
data.  

1. Generate history tick data from M1 candles 

2. Download tick data from a 3rd party data provider  

The 1st option – generating tick data from M1 candles – has the advantage that it doesn’t need any 
external website and can be used on all instruments that are present in MT4. The drawback is that 
the generated history tick data is simulated (based on Open, High, Low, Close values of M1 candles), 
so – although it is very similar to the real tick chart – there is no real tick data behind the tick 
candles. 

The 2nd option – downloading tick data from a 3rd party data provider (currently Dukascopy) – has 
the advantage that it is real tick data collected from the market, so it is as accurate as it can be. 
Unfortunately it has the drawback that the data provider doesn’t provide tick data for all 
instruments, only the most popular ones. It also needs an external website to download data from 
and downloading is somewhat slower than generating tick data from M1 candles.  

Downloading tick data usually takes some time. The download time depends on many factors for 
example how many instruments need to download tick data at once, how many hours of tick data is 
downloaded, what is the speed of your internet connection… etc. MetaTrader 4 may become 
unresponsive during the downloading process, in this case please be patient. Typical download times 
may range between a few seconds and 45-60 seconds depending on the factors mentioned above, 
but sometimes under special circumstances the download may take minutes. 

For the downloaded tick data the terms and conditions of Dukascopy apply. These can be found at 
https://www.dukascopy.com/swiss/english/marketwatch/historical . Use the tick data download function only if you agree 
with the above terms and conditions. Please also be aware that the 3rd party provider (currently Dukascopy) can anytime 
change or completely stop providing history tick data for the public. As a result, this feature is provided ‘as is’ without 
warranty of any kind and it is not guaranteed that it will work in the future.   

The amount of the downloaded history tick data depends on setting ‘Max age of history tick data’. 
The default setting for ‘Max age of history tick data’ is ‘60’, so 60 hours of history tick data will be 
downloaded if you use the default setting. 
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https://www.dukascopy.com/swiss/english/marketwatch/historical


 

Sometimes it can happen that the tick chart looks messed up or it shows a strange, incorrect candle 
pattern (e.g. such situation can happen if you start MT4 after a few days pause).  

 

 

In such case it is possible to force the re-download or re-generation of tick data. To do that you need 
to open the Quick Control Bar by clicking on the little arrow in the lower left corner of the indicator 
window. When the Quick Control Bar appears and you hover your mouse cursor over the ‘RELOAD’ 
button, you can read the instructions.  

 

 

For a simple reloading of the current tick chart simply press the ‘RELOAD’ button. Most of the times 
this is enough and the chart will be corrected after reloading it. 

If it is still not correct, press and hold SHIFT button on your keyboard while pressing the ‘RELOAD’ 
button on the Quick Control Bar in the indicator window.  This will trigger the removal of tick data 
files and they will be re-downloaded or re-generated. 

Finally if the chart still doesn’t look correct, it is possible that you are watching a commodity/index 
chart and you forgot to choose the appropriate commodity/index at field ‘If downloading history, 
select the symbol’ in indicator settings (or you selected the wrong one). Please re-check the settings. 
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Quick Control Bar 
 

If you are using the tick chart in the indicator window, you may notice a small arrow in the lower left 
corner of the indicator window (see it marked with red arrow on the screenshot).  

 

 

You can show and hide the Quick Control Bar by clicking on this small arrow. The Quick Control Bar 
lets you change the tick volume (called ‘Number of ticks per candle’ at indicator settings) and history 
(called ‘Max age of history tick data’) on the fly and you can also reload/regenerate the tick chart 
with the ‘RELOAD’ button if the tick chart gets messed up because of some MT4 issues. 

 

 

Additional Indicators 
 

In the downloaded .ZIP file there are additional indicators included, for example:  RWTC.Stochastic, 
RWTC.MACD, RWTC.CCI… etc. These are modified versions of MT4 built-in indicators. They have 
been modified to be tick chart based, so you can add these indicators to the same main chart as RW 
Tick Chart indicator and they will move in sync with the tick chart showing tick chart based values. 
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Tips 
 

Some tips and hints to make your life easier: 

1-tick chart – if you would like to use 1-tick chart, the following settings are recommended:  Number 
of ticks per candle = 1, Moving Average = Enabled, MA method = Simple, MA period = 1.  You can set 
the line (connecting the tick price values) color at the Colors tab of the indicator settings window 
(where you set the color of the MA line – it’s the third setting with id #3): 

     

 

Middle line for Bollinger Bands – to display the middle line for Bollinger Bands – which is a Simple 
Moving Average – just set the first Moving Average to the same period as the Bollinger Bands and 
set the MA method to ’Simple’. The color of the line can be set at the Colors tab of indicator settings 
window by editing the color for buffer #3. You can disable second MA by setting ’Second Moving 
Average’ to OFF. 

 

Economy Calendar – clicking the red padlock  icon in the upper right corner of the chart opens a 
browser window with an economy calendar located at www.rwtickchart.com/eco.htm  

 

Saved files – sometimes it is worth to check MetaTrader4 data folder\MQL4\Files\RWtickchart.com 
directory and delete old files to save disk space. 

 

RW Tick Chart settings and performance impact – if you have a slower computer you may need to 
select the following settings carefully to decrease the performance impact on your computer:  ‘Max 
number of candles in indicator window’ and ‘Max age of history tick data’. The higher values you set, 
the greater the performance impact will be. Using offline charts also has some performance impact. 
To minimize this it is recommended to use higher value tick charts (e.g. 50-tick chart or greater) or 
set ‘offline chart updating’ to ‘tick candle close’ or ‘every 50th tick’ instead of ‘every tick’. 
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Contact Us 
 

You can find some more information, recent news, and useful links on the following website: 

http://www.rwtickchart.com 

To contact us with questions, comments, feedback, suggestions please visit this page: 

http://www.rwtickchart.com/contact.php 

 

 

Follow Us 
 

On Facebook: 

http://www.facebook.com/RWtickchart 

On Twitter: 

http://twitter.com/RWtickchart 

 

 

Risk Disclaimer 
 

RISKS ASSOCIATED WITH FOREX TRADING  

  Speculative trading in the foreign exchange market can be a challenging and potentially profitable opportunity for investors. However before deciding to participate in the Forex 
market, you should carefully consider your investment objectives, level of experience and risk appetite. Most importantly, do not invest money you cannot afford to lose.  

  There is considerable exposure to risk in any foreign exchange transaction. Any transaction involving currencies involves risks including, but not limited to, the potential for changing 
political and/or economic conditions that may substantially affect the price or liquidity of a currency. Investments in foreign exchange speculation may also be susceptible to sharp rises 
and falls as the relevant market values fluctuate. The leveraged nature of Forex trading means that any market movement will have an equally proportional effect on your deposited 
funds. This may work against you as well as for you. Not only may investors get back less than they invested, but in the case of higher risk strategies, investors may lose the entirety of 
their investment. It is for this reason that when speculating in such markets it is advisable to use only risk capital.  

 RISK DISCLAIMER  

  Trading foreign exchange on margin carries a high level of risk and may not be suitable for all investors. Past performance is not indicative of future results. The high degree of leverage 
can work against you as well as for you. Before deciding to invest in foreign exchange you should carefully consider your investment objectives, level of experience and risk appetite. The 
possibility exists that you could sustain a loss of some or all of your initial investment and therefore you should not invest money that you cannot afford to lose. You should be aware of 
all the risks associated with foreign exchange trading, and seek advice from an independent financial advisor if you have any doubts.  

  Only you are liable for your investment, trading decisions and the results there from, and you agree to hold the author and any other entities associated with this website without 
liability from your investment decisions and the results there from. Please use your due diligence and govern yourself accordingly.  

 LIABILITY DISCLAIMER  

  By purchasing and using this indicator the customer agrees that the author and any other entities associated with this document or the corresponding website shall not be held liable 
for any direct, indirect, consequential loss or any damages arising from the use of any information, signals, software, indicator, messages, manual, instructions, alerts or directives in this 
document or from the corresponding website. Use this document, software, indicator and any services offered at your own risk. Neither guarantee of performance, results nor any 
anticipated return of investment is offered at any time.  

  The information, software and indicators contained in this document and the corresponding website are provided in good faith, and every reasonable effort is made to ensure that 
their quality is up to expectations. However this information, software and indicator is provided 'as is' without warranty of any kind. In no event shall the author be liable for any damage 
arising, directly or indirectly, from the use of the information, software or indicator contained in this document or the corresponding website including damages arising from 
inaccuracies, omissions or errors. Any person relying on or making use of any of the information, software or indicator contained in this document or the corresponding website shall do 
so at its own risk. The author hereby disclaims any liability and shall not be held liable for any damages including, without limitation, direct, indirect or consequential damages including 
loss of profit, loss of opportunity or any other loss. 
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